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COMPUTER FUNDAMENTALS 
 

What is Computer? 

It is an electronic machine which takes the data as input and gives the information as output. 

 

 Data and Information 

What is Data?   

Data can be defined as a representation of facts, concepts, or instructions, which should be suitable for 
communication, interpretation, or processing, by human or electronic machine. 

Data is represented with the help of characters such as alphabets (A-Z, a-z), digits (0-9) or special 
characters (+,-,/,*,<,>,= etc.) 

What is Information? 

Information is organized or classified data, which has some 
meaningful values for the receiver. Information is the processed 
data on which decisions and actions are based. 

For the decision to be meaningful, the processed data must 
qualify for the following characteristics − 

• Timely − Information should be available when required. 

• Accuracy − Information should be accurate. 

• Completeness − Information should be complete. 
 

 

S.No. Operation Description 

1 Take Input 
The process of entering data and instructions into the 
computer system. 

2 Store Data 
Saving data and instructions so that they are available for 
processing as and when required. 

3 Processing Data 
Performing arithmetic, and logical operations on data in 
order to convert them into useful information. 
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4 
Output 

Information 

The process of producing useful information or results for 
the user, such as a printed report or visual display. 

5 
Control the 

workflow 

Directs the manner and sequence in which all of the 
above operations are performed. 

Input (Data): 

Input is the raw information entered into a computer from the input devices. It is the collection of 

Letters, numbers, images etc. 

Process: 

Process is the operation of data as per given instruction. It is totally internal process of the computer 

System. 

Output: 

Output is the processed data given by computer after data processing. Output is also called as Result. 

We can save these results in the storage devices for the future use. 
 

Functions of a Computer 

If we look at it in a very broad sense, any digital computer carries out the following five functions − 

Step 1 − Takes data as input. 

Step 2 − Stores the data/instructions in its memory and uses them as required. 

Step 3 − Processes the data and converts it into useful information. 

Step 4 − Generates the output. 

Step 5 − Controls all the above four steps. 
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Computer - Applications 

Here we will learn about the application of computers in various fields. 

Business 

 

A computer has high speed of calculation, accuracy, reliability, or versatility 
which has made it an integrated part in all business organizations. 

Computer is used in business organizations for − 

• Payroll calculations 

• Budgeting 

• Sales analysis 

• Financial forecasting 

• Managing employee database 

• Maintenance of stocks, etc. 

Banking 

Today, banking is almost totally dependent on computers. 

Banks provide the following facilities − 

• Online accounting facility, which includes checking current balance, 
making deposits and overdrafts, checking interest charges, shares, 
and trustee records. 

• ATM machines which are completely automated are making it even easier for customers to deal 
with banks. 

Insurance 

Insurance companies are keeping all records up-to-date with the help of computers. 
Insurance companies, finance houses, and stock broking firms are widely using 
computers for their concerns. 

Insurance companies are maintaining a database of all clients with information showing − 

• Procedure to continue with policies 

• Starting date of the policies 

• Next due instalment of a policy 

• Maturity date 

• Interests due 

• Survival benefits 

• Bonus 
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Education 

• The computer helps in providing a lot of facilities in the 
education system. 

• The computer provides a tool in the education system known as  

• CBE (Computer Based Education). 

• CBE involves control, delivery, and evaluation of learning. 

• Computer education is rapidly increasing the graph of number of computer students. 

• There are a number of methods in which educational institutions can use a computer to educate 
the students. 

• It is used to prepare a database about performance of a student and analysis is carried out on this 
basis. 

Marketing 

In marketing, uses of the computer are following − 

• Advertising − With computers, advertising professionals create art and 
graphics, write and 
 revise copy, and print and disseminate ads with the goal of selling more products. 

• Home Shopping − Home shopping has been made possible through the use of computerized 
catalogues that provide access to product information and permit direct entry of orders to be filled 
by the customers. 

Healthcare 

Computers have become an important part in hospitals, labs, and dispensaries. 
They are being used in hospitals to keep the record of patients and medicines. It 
is also used in scanning and diagnosing different diseases. ECG, EEG, ultrasounds 
and CT scans, etc. are also done by computerized machines. 

Engineering Design 

• Computers are widely used for engineering purpose. 

• One of the major areas is CAD (Computer Aided Design) that 
provides creation and modification of images.  

Military 

Computers are largely used in defence. Modern tanks, missiles, weapons, etc. Military also employs 
computerized control systems. Some military areas where a computer has been used are − 

• Missile Control 

• Military Communication 

• Military Operation and Planning 

• Smart Weapons 
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Communication 

Communication is a way to convey a message, an idea, a picture, or speech that is received and 
understood clearly and correctly by the person for whom it is meant.  

Some main areas in this category are − 

• E-mail 

• Chatting 

• Usenet 

• FTP 

• Telnet 

• Video-conferencing 
 

 

Government 

Computers play an important role in government services.  

Some major fields in this category are − 

• Budgets 

• Sales tax department 

• Income tax department 

• Computation of male/female ratio 

• Computerization of voters lists 

• Computerization of PAN card 

• Weather forecasting 

 



www.compuhelp.in                                                                                https:www.youtube.com/c/compuhelpindia                         
 

6 

                SCO 74 Level-II Sec 46 C Chandigarh (U.T). Contact: +91 – 9915005347, 9988365347       

     
 
 

Computer - Input Devices 

Following are some of the important input devices which are used in a computer − 

• Keyboard 

• Mouse 

• Joy Stick 

• Light pen 

• Scanner 

• Microphone 

• Bar Code Reader 

Keyboard 

Keyboard is the most common and very popular input device which helps to 

input data to the computer. The layout of the keyboard is like that of 

traditional typewriter, although there are some additional keys provided for 

performing additional functions. 

 

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 108 keys are also 
available. The keys on the keyboard are as follows − 

S.No Keys & Description 

1 

Typing Keys 

These keys include the letter keys (A-Z) and digit keys (0-9) which 
generally give the same layout as that of typewriters. 

2 

Numeric Keypad 

It is used to enter the numeric data or cursor movement. Generally, it 
consists of a set of 17 keys that are laid out in the same configuration 
used by most adding machines and calculators. 

3 

Function Keys 

The twelve function keys are present on the keyboard which is arranged 
in a row at the top of the keyboard. Each function key has a unique 
meaning and is used for some specific purpose. 
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4 

Control keys 

These keys provide cursor and screen control. It includes four directional 
arrow keys. Control keys also include Home, End, Insert, Delete, Page Up, 
Page Down, Control(Ctrl), Alternate(Alt), Escape(Esc). 

5 

Special Purpose Keys 

Keyboard also contains some special purpose keys such as Enter, Shift, 
Caps Lock, Num Lock, Space bar, Tab, and Print Screen. 

 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-control device having a small palm 
size box with a round ball at its base, which senses the movement of the mouse and sends corresponding 
signals to the CPU when the mouse buttons are pressed. 

Generally, it has two buttons called the left and the right button and a wheel is present between the 
buttons. A mouse can be used to control the position of the cursor on the screen, but it cannot be used to 
enter text into the computer. 

Advantages  

• Easy to use 

• Not very expensive 

• Moves the cursor faster than the arrow keys of the keyboard. 

Joystick 

Joystick is also a pointing device, which is used to move the cursor 
position on a monitor screen. It is a stick having a spherical ball at its 
both lower and upper ends. The lower spherical ball moves in a socket. 
The joystick can be moved in all four directions.  

The function of the joystick is similar to that of a mouse. It is mainly used 
in Computer Aided Designing (CAD) and playing computer games. 

Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a 
displayed menu item or draw pictures on the monitor screen. It 
consists of a photocell and an optical system placed in a small tube. 

When the tip of a light pen is moved over the monitor screen and the 
pen button is pressed, its photocell sensing element detects the 
screen location and sends the corresponding signal to the CPU. 
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Scanner 

Scanner is an input device, which works more like a photocopy machine. It is used 
when some information is available on paper and it is to be transferred to the 
hard disk of the computer for further manipulation. 

Scanner captures images from the source which are then converted into a digital 

form that can be stored on the disk. These images can be edited before they are 

printed. 

Microphone 

Microphone is an input device to input sound that is then stored in a digital form. 
The microphone is used for various applications such as adding sound to a 
multimedia presentation or for mixing music. 

Bar Code Readers  

Bar Code Reader is a device used for reading bar coded data (data in the form 
of light and dark lines). Bar coded data is generally used in labeling goods, 
numbering the books, etc. It may be a handheld scanner or may be embedded 
in a stationary scanner. 

Computer - Output Devices 

Following are some of the important output devices used in a computer. 

• Monitors 

• Printer 
 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It 
forms images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the 
image depends upon the number of pixels. 

Types of Displays 

CRT or Cathode Ray Tube Monitor 
CRT stands for cathode-ray tube and is a technology has been around for a long 
time 

 
 
LCD or Flat Panel Monitor  
LCD stands for liquid crystal display and although it may seem like this is a new 
technology it has been used in digital watches for years. The technology works by 
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passing an electric current through liquid crystal which is contained between two sheets of polarizing 
material. 

   
LED and OLED - Light Emitting Diode or Organic LED works without a backlight.  

   
 

Plasma Display – is a type of flat panel display that utilizes small cells 
containing electrically charged ionized gas.  
  
 

 
 

Projectors – Use for presentation the 3 types of projectors are (CRT, LCD and DLP) 
Digital Light Processing 

 

Printers 

Printer is an output device, which is used to print information on paper. 

There are two types of printers − 

• Impact Printers 

• Non-Impact Printers 

Impact printers 

An impact printer makes contact with the paper. It usually forms the print image by pressing an inked 
ribbon against the paper using a hammer or pins. Following are some examples of impact printers. 

 Dot-Matrix Printers  

The dot-matrix printer uses print heads containing from 9 to 24 pins. These 
pins produce patterns of dots on the paper to form the individual characters. 
The general rule is: the more pins, the clearer the letters on the paper.  

           The pins strike the ribbon individually as the print mechanism moves 
across the entire print line in both directions, i-e, from left to right, then right 
to left, and so on.  
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Daisy-wheel printers  

In order to get the quality of type found on typewriters, a daisy-wheel impact 
printer can be used. It is called daisy-wheel printer because the print 
mechanism looks like a daisy; at the end of each “Petal” is a fully formed 
character which produces solid-line print.  

A hammer strikes a “petal” containing a character against the ribbon, and the 
character prints on the paper. Its speed is slow typically 25-55 characters per 
second. 

Line printers  

In business where enormous amount of material are printed, the character-at-a-
time printers are too slow; therefore, these users need line-at-a-time printers. 
Line printers, or line-at-a-time printers, use special mechanism that can print a 
whole line at once; they can typically print the range of 1,200 to 6,000 lines per 
minute. Drum, chain, and band printers are line-at-a-time printers. 

 

Drum printer  

A drum printer consists of a solid, cylindrical drum that has raised characters 
in bands on its surface.  

 

Non-impact printers 

Non-impact printers do not use a striking device to produce characters on the paper; and because these 
printers do not hammer against the paper they are much quieter. Following are some non-impacted 
printers. 

Ink-jet printers  

Ink-jet printers work in the same fashion as dot-matrix printers in the form 
images or characters with little dots. However, the dots are formed by tiny 
droplets of ink. 

 Ink-jet printers form characters on paper by spraying ink from tiny nozzles 
through an electrical field that arranges the charged ink particles into 
characters at the rate of approximately 250 characters per second. The ink 
is absorbed into the paper and dries instantly. Various colours of ink can also be used. 

Laser printers  

A laser printer works like a photocopy machine. Laser printers produce images 
on paper by directing a laser beam at a mirror which bounces the beam onto a 
drum. The drum has a special coating on it to which toner (an ink powder) 
sticks.  
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Memory 
Memory is that component of computer in which data or information is stored. 
 

 

 
 
 
 

 

Primary Memory (Main Memory)  

Primary memory holds only those data and instructions on which the computer 
is currently working. It has a limited capacity and data is lost when power is 
switched off. It is divided into two subcategories RAM and ROM.  

Characteristics of Main Memory 

• It is known as the main memory. 

• Usually volatile memory. 

• Data is lost in case power is switched off. 

• It is the working memory of the computer. 

• Faster than secondary memories. 

• A computer cannot run without the primary memory. 

Random Access Memory (RAM) 

RAM (Random Access Memory) is the internal memory of the CPU for storing 
data, program, and program result. It is a read/write memory which stores data 
until the machine is working. As soon as the machine is switched off, data is 
erased. 
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 Read Only Memory (ROM) 

ROM stands for Read Only Memory. The memory from which we can only read 
but cannot write on it. This type of memory is non-volatile. The information is 
stored permanently in such memories during manufacture. 

                    A ROM stores such instructions that are required to start a computer. 
This operation is referred to as bootstrap. ROM chips are not only used in the 
computer but also in other electronic items like washing machine and microwave 
oven. 

Advantages of ROM 

The advantages of ROM are as follows − 

• Non-volatile in nature 

• Cannot be accidentally changed 

• Cheaper than RAMs 

• Easy to test 

• More reliable than RAMs 

• Static and do not require refreshing 

• Contents are always known and can be verified 
 
 
 

Secondary Memory 

This type of memory is also known as external memory or non-volatile. It is slower than the main 
memory. These are used for storing data/information permanently. CPU directly does not access these 
memories.  

                                 The contents of secondary memories are first transferred to the main memory, and 
then the CPU can access it. For example, disk, CD-ROM, DVD, etc. 

 

Characteristics of Secondary Memory 

• These are magnetic and optical memories. 

• It is known as the backup memory. 

• It is a non-volatile memory. 

• Data is permanently stored even if power is switched off. 

• It is used for storage of data in a computer. 

• Computer may run without the secondary memory. 

• Slower than primary memories. 
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HARD DISK 

A hard disk drive [HDD], commonly referred to as a hard drive, hard disk or fixed disk drive. It is a non-
volatile secondary storage device. 

 

 

 

Desktop Hard disk 
from front side. 

Laptop Hard disk  

SSD (Solid state drives) Hard disk 

Desktop Hard disk 
from back side. 
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CD  

It stands for Compact Disk. It has storage capacity of 700 MB or approximately 90 minutes 
of standard audio. CD contains hard circular plastic, single side of this plastic is coated by 
aluminum alloy.  

                        This alloy stores data. It is protected by additional thin plastic covering. CD 
required CD drive for its operation. 

DVD  

It stands for Digital Versatile Disk. It has the storage capacity of 4.7GB to 
17GB. Its shape and size is similar to CD but the difference in storage 
capacity is due to different chemical component and data is compressed 
before storing.  

                      It requires DVD drive for its operation. Read/write speed of DVD 
is slower than that of CD.  

Pen drive  

It is a flash memory. It is a semi-conductor memory. It is mainly used for transferring 

data. It has faster read/write speed compared to magnetic memory. 

             Pen drive has storage capacity of few MB-GB. A pen drive is a plug and play 

device. A pen drive can be connected with the computer through USB port.  

 

Portable hard disk  

it is a magnetic hard disk. It can be connected with the computer through the 

USB port. 

                      It is also a plug and play device. It is mainly used for storing backup. 

It has the storage capacity from few GB-TB. 

 

 

Computer - Memory Units 

Memory unit is the amount of data that can be stored in the storage unit. This storage capacity is 
expressed in terms of Bytes. 
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The following table explains the main memory storage units − 

S.No. Unit & Description 

1 

Bit (Binary Digit) 

A binary digit is logical 0 and 1 representing a passive or an active state of 
a component in an electric circuit. 

2 
Nibble 

A group of 4 bits is called nibble. 

3 

Byte 

A group of 8 bits is called byte. A byte is the smallest unit, which can 
represent a data item or a character. 

The following table lists some higher storage units − 

S.No. Unit & Description 

1 
Kilobyte (KB) 

1 KB = 1024 Bytes 

2 
Megabyte (MB) 

1 MB = 1024 KB 

3 
Gigabyte (GB) 

1 GB = 1024 MB 

4 
Terabyte (TB) 

1 TB = 1024 GB 

5 
Petabyte (PB) 

1 PB = 1024 TB 
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Computer - Generations 

Generation in computer terminology is a change in technology a computer is/was being used. Initially, the 
generation term was used to distinguish between varying hardware technologies. Nowadays, generation 
includes both hardware and software, which together make up an entire computer system. 

There are five computer generations known till date. Each generation has been discussed in detail along 
with their time period and characteristics. In the following table, approximate dates against each 
generation have been mentioned, which are normally accepted. 

 

Following are the main five generations of computers 

 

S.No Generation & Description  

1 

First Generation  

The period of first generation: 1946-1959. Vacuum tube based. 

 

2 

Second Generation 

The period of second generation: 1959-1965. Transistor based. 

 

3 

Third Generation 

The period of third generation: 1965-1971. Integrated Circuit 
based. 

 

https://www.tutorialspoint.com/computer_fundamentals/computer_first_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_second_generation.htm
https://www.tutorialspoint.com/computer_fundamentals/computer_third_generation.htm
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4 

Fourth Generation 

The period of fourth generation: 1971-1980. VLSI 
(Very Large Scale Integration) microprocessor based.  

 

5 

Fifth Generation 

The period of fifth generation: 1980-onwards. ULSI 

(Ultra large scale integration) microprocessor based. 

 

 

 

                                                                              Computer - Types 

 

Computers can be broadly classified by their speed and computing power. 

S.No. Type Specifications 

1 
PC (Personal 

Computer) 

It is a single user computer system having moderately 
powerful microprocessor 

2 Workstation 

It is also a single user computer system, similar to 
personal computer however a more powerful 
microprocessor has. 

3 Mini Computer 
It is a multi-user computer system, capable of 
supporting hundreds of users simultaneously. 

4 Main Frame It is a multi-user computer system, capable of 
supporting hundreds of users simultaneously. Software 

https://www.tutorialspoint.com/computer_fundamentals/computer_fourth_generation.htm
https://en.wikipedia.org/wiki/Very_Large_Scale_Integration#:~:text=Very%20large%2Dscale%20integration%20(VLSI,telecommunication%20technologies%20to%20be%20developed.
https://en.wikipedia.org/wiki/Very_Large_Scale_Integration#:~:text=Very%20large%2Dscale%20integration%20(VLSI,telecommunication%20technologies%20to%20be%20developed.
https://www.tutorialspoint.com/computer_fundamentals/computer_fifth_generation.htm
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technology is different from minicomputer. 

5 Supercomputer 
It is an extremely fast computer, which can execute 
hundreds of millions of instructions per second. 

 

PC (Personal Computer) 

 

A PC can be defined as a small, relatively inexpensive computer designed for an 
individual user. PCs are based on the microprocessor technology that enables 
manufacturers to put an entire CPU on one chip.  

Although personal computers are designed as single-user systems, these systems are normally linked 
together to form a network.  

Workstation 

Workstation is a computer used for engineering applications, software 
development, and other such types of applications which require a moderate 
amount of computing power and relatively high quality graphics capabilities. 

Workstations generally come with a large, high-resolution graphics screen, 
large amount of RAM, inbuilt network support, and a graphical user interface.  

 

Minicomputer 

It is a midsize multi-processing system capable of supporting up to 250 
users simultaneously. 

 

 

 

Mainframe 

Mainframe is very large in size and is an expensive computer capable of 
supporting hundreds or even thousands of users simultaneously.  

                    Mainframe executes many programs concurrently and supports 
much simultaneous execution of programs. 

Supercomputer 

Supercomputers are one of the fastest computers currently available. 

Supercomputers are very expensive and are employed for specialized 
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applications that require immense amount of mathematical calculations (number crunching). 

For example, weather forecasting, scientific simulations, (animated) graphics, dynamic calculations, 
nuclear energy research, electronic design, and  analysis of geological data  

 

CPU (Cabinet) – Components 

Inside the cabinet, you can expect to see some machinery and a decent number of wires and plugs of 

various sizes criss-crossing all over. However, don’t let that give you the impression that it’s something too 

complex to be understood; if broken down (figuratively, that is) a computer cabinet consists of five major 

components:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

These are the main parts/components of a computer cabinet: 

• Processor 

• Motherboard 

• Hard drive 

• RAM 

• Power supply 
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Processor- CPU (Central Processing Unit) 

 

Also referred to as the CPU (Central Processing Unit), this is the 

most important part of the cabinet. This is where the processing of 

everything that you do on your computer is carried out. However, 

you won’t be able to see it in plain sight when you open the 

cabinet, because there is usually a fan and a heat-sink mounted on 

the processor to ensure sure that it doesn’t overheat.  

https://www.scienceabc.com/wp-content/uploads/2016/01/computer-cabinet.jpg
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Intel and AMD are two leading processor manufacturers; they roll out new variants of existing processors 

every few months. Do the names Pentium, Core i5 and Athlon sound familiar? These are simply popular 

models of processors. 

 

• Pentium I 

• Pentium II 

• Pentium III 

• Pentium IV 

• Pentium V 

 

 

Core 2 Duo 
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Central Processing Unit (CPU) consists of the following features − 

• CPU is considered as the brain of the computer. 

• CPU performs all types of data processing operations. 

• It stores data, intermediate results, and instructions 
(program). 

• It controls the operation of all 
parts of the computer. 

 

CPU itself has following three 
components. 

• Memory or Storage Unit 

• Control Unit 

• ALU(Arithmetic Logic Unit) 

 

Memory  or  Storage Unit 

This unit can store instructions, data, and 
intermediate results. This unit supplies information to other units of the computer when needed.  

It is also known as internal storage unit or the main memory or the primary storage or Random Access 
Memory (RAM). 

Control Unit 

This unit controls the operations of all parts of the computer but does not carry out any actual data 
processing operations. 

Functions of this unit are − 

It is responsible for controlling the transfer of data and instructions among other units of a computer. 

ALU (Arithmetic Logic Unit) 

This unit consists of two subsections namely, 

• Arithmetic Section 

• Logic Section 
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Arithmetic Section 

Function of arithmetic section is to perform arithmetic operations like addition, subtraction, 
multiplication, and division. All complex operations are done by making repetitive use of the above 
operations. 

Logic Section 

Function of logic section is to perform logic operations such as comparing, selecting, matching, and 
merging of data. 

Motherboard 

This is a board that occupies most of the visible space inside the cabinet. Also referred to as the 

mainboard, system board and so on, it is the foundation of any computer. 

 

 

 

The motherboard supplies power to the processor, RAM, hard drive and other hardware components. It 

plays host to every wire and plug that you see inside the cabinet. This is also where the famous RAM 

(Random Access Memory, also known as the primary memory) can be found. The motherboard houses 

other important components too, like a graphics card, LAN card and so on. 

Now you know why it’s known as the ‘mother’board… it takes care of everything! 

                                      Just like they do with processors, manufacturers roll out different variants of 

motherboards to accommodate different functionalities. A particular processor is only compatible with 

certain motherboards and vice-versa. 
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Features of Motherboard 

A motherboard comes with following features − 

• Motherboard varies greatly in supporting various types of components. 

• Motherboard supports a single type of CPU and few types of memories. 

• Video cards, hard disks, sound cards have to be compatible with the motherboard to function 
properly. 

Popular Manufacturers 

Following are the popular manufacturers of the motherboard. 

• Intel 

• ASUS 

• ABIT 

• Gigabyte 

• MSI 
 

Hard Drive 

This is the part of the computer that contains all your childhood 

memories and your exclusive list of songs in the form of huge files. It is 

usually fitted into a slot above the motherboard. It typically measures 

between 2.5” and 3.5” and is a few pounds in weight. This is where all 

information is stored permanently and can be accessed, altered or 

deleted as and when required. A virus attack can adversely affect a hard 

drive. 

It’s not surprising that people are absolutely obsessed with protecting their hard drives; it’s like a bank 

vault for your computer! 

Random Access Memory (RAM) 

RAM (Random Access Memory) is the internal memory of the CPU for storing 
data, program, and program result. It is a read/write memory which stores data 
until the machine is working. As soon as the machine is switched off, data is 
erased. 

Power Supply (SMPS) 

 

Also referred to as SMPS (Switched Mode Power Supply) or PSU 

(Power Supply Unit), this is the part of the cabinet that supplies 

power to each and every component inside the cabinet. It converts a 

220-230 V alternating current to a steady-low direct current to be 
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used by the computer. It usually sits at the top corner of the cabinet, and has a small fan attached to it to 

prevent overheating. 

 

 

 

 

Data Buses 

There are two types of hard drive connections that a computer could have: Parallel AT Attachment 

(PATA), also known as IDE, and Serial AT Attachment (SATA). SATA is most commonly used in nearly all 

computers today, 

 

 

 

CPU-Ports 

A port is a physical docking point using which an external device can be connected to the computer. It can 
also be programmatic docking point through which information flows from a program to the computer or 
over the Internet. 

Characteristics of Ports 

A port has the following characteristics − 

• External devices are connected to a computer using cables and ports. 

• Ports are slots on the motherboard into which a cable of external device is plugged in. 

Examples of external devices attached via ports are the mouse, keyboard, monitor, microphone, speakers, 
etc. 

https://www.computerhope.com/jargon/i/ide.htm
https://www.computerhope.com/jargon/s/sata.htm
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Let us now discuss a few important types of 
ports. 

Serial Port 

• Used for external modems and older 
computer mouse 

• Two versions: 9 pin, 25 pin model 

• Data travels at 115 kilobits per second 

Parallel Port 

• Used for scanners and printers  

• Also called printer port 

• 25 pin model 

• IEEE 1284-compliant Getronics port 

 

PS/2 Port 

• Used for old computer keyboard and 
mouse 

• Also called mouse port 

• Most of the old computers provide two PS/2 port, each for the mouse and keyboard 

Universal Serial Bus (or USB) Port 

• It can connect all kinds of external USB devices such as external hard disk, printer, scanner, mouse, 
keyboard, etc. 

• It was introduced in 1997. 

• Most of the computers provide two USB ports as minimum. 

• Data travels at 12 megabits per seconds. 

• USB compliant devices can get power from a USB port. 

VGA  (Video Graphics Array) Port 

• Connects monitor to a computer's video card. 

• It has 15 holes. 

• Similar to the serial port connector. However, serial port connector has pins, VGA port has holes. 

Power Connector 

• Three-pronged plug. 

• Connects to the computer's power cable that plugs into a power bar or wall socket. 

Fire wire Port 

• Transfers large amount of data at very fast speed. 

• Connects camcorders and video equipment to the computer. 
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• Data travels at 400 to 800 megabits per seconds. 

• Invented by Apple. 

• It has three variants: 4-Pin FireWire 400 connector, 6-Pin FireWire 400 connector, and 9-Pin 
FireWire 800 connector. 

Modem Port 

• Connects a PC's modem to the telephone network. 

Ethernet Port 

• Connects to a network and high speed Internet. 

• Connects the network cable to a computer. 

• This port resides on an Ethernet Card. 

• Data travels at 10 megabits to 1000 megabits per seconds depending upon the network 
bandwidth. 
 

Game Port 

• Connect a joystick to a PC 

• Now replaced by USB 

Digital Video Interface, DVI port 

• Connects Flat panel LCD monitor to the computer's high-end video graphic cards. 

• Very popular among video card manufacturers. 

Sockets 

• Sockets connect the microphone and speakers to the sound card of the computer. 
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Software 
Software is a set of programs, which is designed to perform a well-defined function. A program is a 
sequence of instructions written to solve a particular problem. 

There are two types of software − 

• System Software 

• Application Software 

 

 

 

 

System Software 

The system software is software which is used by computer system. It is a collection of programs designed 
to operate, control, and extend the processing capabilities of the computer itself. System software is 
generally prepared by the computer manufacturers.  

Some examples of system software are Operating System, Compilers, Interpreter, Assemblers, etc. 
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Here is a list of some of the most prominent features of system software − 

• Close to the system 

• Fast in speed 

• Difficult to design  

• Difficult to understand 

• Less interactive 

• Smaller in size 

• Difficult to manipulate 

• Generally written in low-level language 
 

Types of Operating System: 
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Application Software 

Application software is a software which is used by user. Application software products are designed to 
satisfy a particular need of a particular environment. All software applications prepared in the computer 
lab can come under the category of Application software. 

Application software may consist of a single program, such as Microsoft's notepad for writing and editing 
a simple text. It may also consist of a collection of programs, often called a software package, which work 
together to accomplish a task, such as a spreadsheet package e.g. MS-Office. 

Examples of Application software are the following − 

• Payroll Software 

• Student Record Software 

• Inventory Management Software 

• Income Tax Software 

• Railways Reservation Software 

• Microsoft Office Suite Software 

• Microsoft Word 

• Microsoft Excel 

• Microsoft PowerPoint 

 

Features of application software are as follows − 

• Close to the user 

• Easy to design 

• More interactive 

• Slow in speed 

• Generally written in high-level language 

• Easy to understand 

• Easy to manipulate and use 
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                                                        Booting 

Booting: When we start our Computer then there is an operation which is performed automatically by the 
Computer which is also called as Booting. In the Booting, System will check all the hardware’s and 
Software’s those are installed or Attached with the System and this will also load all the Files those are 
needed for running a system. 

In the Booting Process all the Files those are Stored into the ROM Chip will also be Loaded for Running the 
System. In the Booting Process the System will read all the information from the Files those are Stored 
into the ROM Chip and the ROM chip will read all the instructions those are Stored into these Files. After 
the Booting of the System this will automatically display all the information on the System. The 
Instructions those are necessary to Start the System will be read at the Time of Booting. 

 

 

Types of booting 

 

 

 

 

 

 

http://ecomputernotes.com/fundamental/information-technology/what-do-you-mean-by-data-and-information
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                                                        Internet and Intranet 

Internet  

It is a worldwide/global system of interconnected computer networks. It uses the standard Internet 
Protocol (TCP/IP). Every computer in Internet is identified by a unique IP address. IP Address is a unique 
set of numbers (such as 110.22.33.114) which identifies a computer’s location.  

A special computer DNS (Domain Name Server) is used to provide a name to the IP Address so that the 
user can locate a computer by a name. For example, a DNS server will resolve a name www.compuhelp.in 
to a particular IP address to uniquely identify the computer on which this website is hosted. 

 

 

 

 

 

 

 

 

 

 

 

So, Internet is network of networks. 

Internet is accessible to every user, all over the world. 

 

Intranet 

Intranet is the system in which multiple PCs are connected to each other. PCs in intranet are not available 
to the world outside the intranet. Usually each organization has its own Intranet network and 
members/employees of that organization can access the computers in their intranet. 
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Each computer in Intranet is also identified by an IP Address which is unique among the computers in that 
Intranet. 

Similarities between Internet and Intranet 

• Intranet uses the internet protocols such as TCP/IP and FTP. 

• Intranet sites are accessible via the web browser in a similar way as websites in the internet. 
However, only members of Intranet network can access intranet hosted sites. 

• In Intranet, own instant messengers can be used as similar to yahoo messenger/gtalk over the 
internet. 

Differences between Internet  and  Intranet 

• Internet is general to PCs all over the world whereas Intranet is specific to few PCs. 

• Internet provides a wider and better access to websites to a large population, whereas Intranet is 
restricted. 

• Internet is not as safe as Intranet. Intranet can be safely privatized as per the need. 
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Microsoft Word 2007 Basics 
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Microsoft Word 2007 Basics 

Microsoft Word 2007 has a completely redesigned user interface.  The standard menus along the top have 
been removed and replaced with a series of toolbars Microsoft calls “The Ribbon.”  These tool bars are 
changed using tabs at the top and try to automatically adjust themselves to the content you are working 
with.  If you select an image it will automatically switch to the picture tools.  The new layout seems to offer 
easier access to most of the features of Word allowing for more complex documents to be created quicker. 

The Office Logo 

The first thing most people will need to relearn is where to go to open a document, 
create a new one, save your document and print.  Clicking the Office logo at the 
top left of the screen will provide most of the items formerly found under the file 
menu including those listed above.   Beside the logo you also will find a disk icon to 
save your document as well as the undo and redo buttons.  More buttons can be 
added to this “Quick Access Toolbar” through the word options mentioned in the 

next section. 
 

As you can see here the Office logo opens up listing your 
options for new, open etc. and also contains a list of your 
recent documents for quick opening.  Any of the items 
listed with an arrow beside them will replace the recent 
documents on the right with the options associated with 
the menu item.  You should also see at the bottom right of 
this menu a button for exiting Word and changing Word’s 
options. 

Save as 

The save as option will provide you with the most common 
file formats to save your document in.  The common ones 
are Word Document, Word Template, and Word 97-2003 
document.  The last one is the option most people should 
be using currently, especially if they wish to share 
documents with others who do not have the new version 
of Office. 
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Print 

Here you can choose from Print, Quick Print and Print Preview.  Print brings up the standard print dialog 
box, quick print will print one copy without any dialog box coming up and print preview will bring up the 
print preview screen. 

Prepare 

The prepare menu’s most common options are Properties, Inspect Document, Mark as Final and Run 
Compatibility Checker.  The properties option allows you to setup metadata for the document like Author, 
Title, keywords, comments and others.  Inspect Document will scan the document for any hidden data like 
comments and annotations, and any hidden collaboration data.   
                                                                                                     This is very useful when making a previously 
private document public.  It will help you find any comments or changes made previously that should not 
be made public.  Mark as Final will mark the document as a final copy and make it read only so changes 
cannot be made.  The last common item, Run Compatibility Checker will scan the document for new 
features that were used and show you these.  This is recommended if you where creating a document in 
the new file format but now need to convert it back to the Office 2003 format to share with someone who 
does not have Office 2007. 

The Home Tab 

 
The home tab the basic formatting tools found in Word 2007.  You will find five sections, Clipboard, Font, 
Paragraph, Styles and Editing.  Clicking the down arrow beside any of the icons here will drop down more 
options for that tool.  Each section also contains an arrow in the bottom right corner which will open a 
window containing the options found in that section. 

Clipboard 

The Clipboard allows you to cut, copy, paste and copy formatting from one place to 
another. 
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Font 

The font section of the ribbon provides a section to handle the basic text formatting.  Items such as bold, 
underline, strikethrough, highlight and font type can be changed here.  Some items from this section and 
some items from the paragraph section are also available by highlighting text and moving your cursor 
slightly above the highlighted text.  This saves having to move your cursor all the way to the top of the 
screen for some common formatting items. 

 

Paragraph 

The paragraph section provides icons for bullets, lists, justify, line 
spacing, indents and borders. 
 

 

Styles 

The styles section allows you to quickly change the 
formatting of a section of text by choosing one of 

the predefined styles.  You can also create a new style based on the formatting of your selected text for 
use later in other sections of your document.   

 

Editing 

The Editing section of the toolbar allows you to find, replace and select items.  The select 
option gives you the ability to select all, select objects or select text with similar formatting.  
This last option gives you the ability to quickly change everything in your document with 

one style to another style without having to manually find all of that text and change each area separately. 
 

Insert Tab 

 
The insert tab has seven sections for inserting most types of objects.  The sections are pages, tables, 
illustrations, links, header and footer, text and symbols.   
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Pages 

The pages section is where you can go to insert an cover page, blank page or page break.  
The cover page drop down offers a selection of predefined cover pages for your 
document that have sections for title, date and author.  You can also select text in your 

document and choose to save the selected text to the cover page gallery for use in future documents. 
 

Table 

The table section only has a drop down menu which offers a grid to create a new table, insert 
table, draw table, convert text to table for selected text, Excel spreadsheet, and some 

predefined “Quick Tables” that have formatting already setup for you.  When working on a table you will 
have two additional tabs along the top of the ribbon, the design and layout tabs.  There are screenshots of 
both directly below. 

Table Design 

 

Table Layout 

 

 

Illustrations 

The Illustrations section allows you to insert pictures, clipart, shapes, 
SmartArt and charts.  After inserting or selecting a picture you are provided 

with a new toolbar along the top shown here.   This toolbar gives you the ability to change the brightness, 
contrast, shape, position, text wrapping and other options for the picture.  Clicking off the picture or on 
one of the other tabs will take you back to the standard toolbars.  The Shapes option of the Illustrations 
section allows you to insert lines, arrows, boxes, basic flowchart shapes and a number of others.  The 
SmartArt option provides features like org charts, flow charts, illustrated lists and processes.  The Chart 
option is similar to Word 2003 but it offers more options for your charts. 
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Links 

The links section provides options for inserting hyperlinks, bookmarks and cross-
references.  Cross-references can link to figures, tables, equations, endnotes, 
footnotes, headers and numbered items. 

 
 

Header & Footer 

The header & footer section allows you to edit the header, footer and page 
numbering for your document.  Once you select this option it will change the 

toolbar along the top to include a larger number of options for the header and footer.   The header bar is 
shown here.  In order to stop editing the header and footer you need to click the “Close Header and 
Footer” button on the right of the bar.  

 
 

Text 

Options in the text section include text box, drop cap, WordArt and a 
number of predefined text blocks like a signature line the date and time,  and document properties like 
abstract, author,  and title.  There are a lot of option in here to setup on your own or you can use Words 
predefined options. 

 

Symbols 

The last option in the insert toolbar is symbols.  Here you can insert a large number of special 
characters and symbols.  Choosing the “more symbols” option from the drop down will also allow you to 
setup shortcut keys for commonly used symbols.  One of the improved features of Word 2007 is the 
equation editor.  You can now insert more complicated mathematical and statistical equations.  Here there 
are some standard equations to chose from or you can create your own.  Standards like 

 ,the binomial theorem are available or,  by choosing “Insert new equation” you 

will get the equation toolbar.  Which gives you a large number of options to chose from while creating your 

own equation.  
 

  The equations can be edited in the new Word 2007 file format 
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however, once they are converted to a Word 2003 format they will become images which cannot be 
edited. 
 

Page Layout Tab 

 
The page layout tab has five sections, Themes, Page Setup, Page Background, Paragraph, and Arrange.   
 

Themes 

The themes section provides a quick way to format your document.  By choosing a theme 
you will have a set colour scheme, font combinations, and effects.  You can choose one of 

the provided themes, modify a provided them or create your own.  You can also go online in this section 
and browse Microsoft.com for additional themes.  Be aware that changing your theme after creating a 
document may require you to reformat some items as themes also include some layout options. 

 

Page Setup 

Page setup provides you with the tools to change margins, size, 
orientation, columns, breaks, line numbers and hyphenation in 

the document.   
 

 

Page Background 

The page background section allows you to change the background colour of the 
document, watermark and draft or confidential document or add borders to your 

document. 
 

Paragraph 

The paragraph section in the page layout tab allows changes to a 
paragraphs spacing and indentation. 
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Arrange 

The arrange section is also found in the image toolbar when an image is 
selected.  Here you can change an images position, how text moves around the image, the alignment, 
grouping and rotation or the image. 
 

References Tab 

 
The references tab contains six sections, Table of Contents, Footnotes, Citations & Bibliography, Captions, 
Indexes and Table of Authorities. 

 

Table of Contents 

The table of contents section allows you to insert and modify the table of contents.  
You can insert automatic or manual table of contents and change what styles will be included in the table 
of contents, if any.  You can also add text to the table and update the table of contents after adding or 
removing items from your document. 
 

 

Footnotes 

This section allows you to insert footnotes and endnotes and move through your 
existing footnotes quickly. 

 

Citations & Bibliography 

This section provides tools to insert citations, manage sources, citation style 
and bibliography.   

 
 

Captions 

Insert captions, table of figures, or cross-references in this section.  Once you 
have created a table of figures you can also update the table at the click of a 
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button. 
 

Index 

This section allows you to create an index, update the index and mark and item for 
inclusion in the index. 
 

 

Table of Authority 

This section allows you to create a table of authorities, update the table and mark and 
citations for inclusion in the table of authorities. 
 

Mailings Tab 

 
The mailings tab contains five sections, create, start mail merge, write & insert fields, preview results and 
finish. 

 

Create 

The create section provides a window to create envelopes or labels.  This is mostly for 
creating single envelopes, labels or a sheet of the same label. 

 

Start Mail Merge 

The main features of this section are start mail merge, select recipients and edit 
recipient list.  The method most people will likely use to create a mail merge in Word 2007 is the step by 
step mail merge wizard found in the start mail merge drop down list.  This option will bring up a wizard 
along the right side of the screen that will walk you through the process.  Recipients can come from 
Outlook contact or a large number of files including Access, Paradox, Excel, Word, CSV and even HTML. 

 

Write & Insert Fields 

This section provides the tools necessary to make a 
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document into one that will work with a mail merge.  You can Highlight merge fields, work with address 
block or greeting line, insert new merge fields, setup rules, match fields and update your labels. 

 

Preview Results 

This section allows you to preview your merge before completing it.  Make sure 
all your recipients fit onto one page, the formatting remained the same after merging, look for specific 
recipients and even have Word auto check for common errors.   
 

 

Finish 

The final section in the mailings tab completes your mail merge.   
 

Review Tab 

 
The review tab offers six sections which include proofing, comments, tracking, changes, compare and 
protect. 
 
 

Proofing 

The proofing section provides the standard spelling and grammar check, a 
thesaurus, word count, research tools that include MSN search and Microsoft Encarta encyclopedia.  You 
will also find translation tools to help with single words or the whole document.  The translation of the 
entire document is done by an online service called Wordlingo. 
 

Comments 

The comments section allows you to add comments to a document for easier 
collaboration.  You can cycle through the comments to find out what notes you left for yourself or others 
and you can delete a comment that was made when it is no longer relevant. 
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Tracking 

The tracking section can be very helpful with a document that changes a 
lot while composing it.  You can track the changes made, who made them and show the changes in 
balloons off to the side.  Be aware that you must turn this on before it will start to work.  Tracking changes 
does not occur on every document automatically.  You should also be aware that unless you clear the 
changes once the document is final they may be visible to others who receive the document even though 
older changes were not intended for others to view.  You can find all the revisions by turning on the 
balloons for revisions and checking each on and accepting or rejecting it by right clicking on the balloon 
and choosing the correct option.  You can also clear them with the options in the next section of the review 
tab. 

 

Changes 

The changes section allows you to cycle through and accept or reject changes made to the 
document and tracked using the track changes feature.  This should be done before the document is 
considered final so any changes can be cleared and no longer visible if the document is distributed to 
anyone who should not have access to the revisions and comments. 

 

Compare 

This section can be used to compare two versions or a document or help you combine 
two versions of a document.  This can be very helpful when you find you have accidentally been working 
on one version on your local drive and another on the network.  You can take the two documents and step 
through them combining them instead of redoing work that was already done. 

 

Protect 

The protect section gives you options to add a password and protect the document.  You can 
restrict changes to formatting and editing or the whole document.  If you use Windows Live you can also 
manage permissions for specific users who also have Windows Live. 
 

View Tab 
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The view tab offers five sections which include document views, show/hide, zoom, window and macros. 
 

Document Views 

The document views section switches you between print layout, full screen 
reading, web layout, outline and draft views.  Print layout is the default view.  Full screen view removes all 
but a couple of tools from the top of the screen and the rest of the screen is your document.  Web layout 
will take away the empty space on either side of the document if there is any and fill the window as if it 
were a web page.  Outline view changes the look of your document into an almost point form style which 
may help with reviewing main points.  Draft view takes away most of your formatting and images and just 
shows the text.  It also fills the window with your text similar to web layout. 

 

Show/Hide 

The show/hide section will toggle certain tools on or off the screen including 
rulers, gridlines, message bar, document map and thumbnails.  The rulers will show along the top and left 
side of the screen.  Gridlines will cover your entire document inside the margins.  They will be visible on 
screen but don’t print.  The message bar can only be displayed when there is a message to be displayed.  
One common reason for the message bar to display is when macros have been enabled or disabled.  The 
document map and thumbnails will show along the left hand side of the screen. 

 

Zoom 

The zoom section provides tools to zoom into or out of the document.   You can 
choose your own zoom factor or use one of the predefined zoom factors of 100%, one page, two 
pages(side by side), or page width which causes the document to zoom in or out so it fills your window. 

 

Window 

The new window button will open your current 
document in a new window.  The arrange all button will take your currently open windows and stack them 
one on top of the other.  The split button will take your current document and show it in two frames within 
the window one on top of the other.  This will allow you to look at something you wrote on page one while 
working on page twenty.  View side by side allows you to view two windows side by side, once in side by 
side view you can turn on synchronous scrolling so both side scroll at the same time.  Also while in side by 
side mode if you resized either window you can click the reset window position button to have them share 
the screen equally again.  The switch window drop down will allow you to switch between open windows. 
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Macros 

The macros section provides the tools required to work with and create basic macros.  You can 
view existing macros or record your own.  Choose record macro from the drop down and then 

perform the functions you do often, like change the page layout, and style of the document.  Once you 
have done those tasks then stop recording.  You will be able to use that macro over again to shorten the 
steps you need to take every time you need to perform that set of tasks. 
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Microsoft Office Excel 
 
 
 
Microsoft Office Excel is a powerful tool used to create and format spreadsheets. Spreadsheets allow 
information to be organized in rows and tables and analyzed with automatic mathematics. Spreadsheets 
are commonly be used to perform many different types of calculations. 
  
 

 

In this section, you will 
Learn MS-EXCEL  

  
 
 
 
 

 
 
 

 1 
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Getting Started 

 
Microsoft Office Excel is a powerful tool used to create and format spreadsheets. Spreadsheets allow 
information to be organized in rows and tables and analyzed with automatic mathematics. Spreadsheets are 
commonly be used to perform many different types of calculations. 
 
• If you have any questions, feel free to ask a TLC staff consultant for assistance during staffed hours at 

your center. 
 

 

Definitions 
 
Workbook vs. Worksheet – when you open Excel, a new file is created called Book 1 (until you name it 
differently). It is called “Book” because it is a Workbook that is initially made up of three Worksheets 
(accessible from the tabs in the lower left corner of your excel window - see Fig. 1). Think of a three ring 
binder with three sheets of paper in it. As with a binder, you can:  

• Add sheets to your Workbook: Insert > Worksheet, or click on the new worksheet tab to the right of 
the tabs for your existing worksheets  

• Delete worksheets: by right-clicking on the tab of the worksheet you wish to delete, then selecting 
“delete”  

• Re-arrange them: by clicking on the worksheet tab and dragging it to the location you desire  
• Rename worksheets: by double-clicking on the worksheet title 

 
Cell – cells are the basic rectangular building blocks of a spreadsheet. They are assigned an address, gen-
erally referred to as a cell reference, according to their column and row (e.g. the cell in column B at row 3 is 
referenced as cell B3). 
 
Row – rows travel horizontally and are numbered. 
 
Column – columns travel vertically and are assigned letters. 
 
Formula – a mathematical formula used to calculate a result based on data from one or more other cells. 
Often they consist of some combination of the standard mathematical operators ( +, -, *, /) (e.g.: 
=(A1+A5)/B13), but they may also include functions (see below). When you type a formula into a cell, that 
cell will generally display the result obtained by the formula, rather than the formula itself. 
 
Functions – pre-written formulae that perform common (and not so common) calculations, such as sum-
mation and averaging. You can combine many functions and operators in a single formula to obtain more 
complex results (e.g.: =SUM(A1:A13)). 
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 2 
Click on this tab  
for a  new  
worksheet 

 

            Existing 
worksheets 
and associated  
tabs 

Fig. 1: Worksheet tabs 
 



www.compuhelp.in                                                                                https:www.youtube.com/c/compuhelpindia                         
 

51 

                SCO 74 Level-II Sec 46 C Chandigarh (U.T). Contact: +91 – 9915005347, 9988365347       

     
 
 

 
Ribbon 
 
The Ribbon, a panel that houses the command buttons and icons, organizes commands as a set of Tabs, 
each grouping relevant commands (see Fig. 2 below). Each application has a different set of tabs which 
expose the functionality that application offers. For example, while Excel has a tab for the Graphing 
capabilities, Word does not feature the same; instead it has tabs to control the formatting of a text docu-
ment. Within each tab, various related options may be grouped together. The Ribbon is designed to make 
the features of the application more discoverable and accessible with fewer mouse clicks as com-pared to 
the menu-based UI used until Office 2007. It is not possible to remove the Ribbon or replace it with menus 
with the normal Office 2007 functions. However, the Ribbon can be hidden. 
 
*Additionally, the file button has been replaced by the Microsoft office sign in the upper left corner and is 
called the “Office Button.” 
 

Office  
Button (New 

“File” button) 
 
       
       

 Tabs     

    Fig. 2: The ribbon and associated tabs   

Navigating Cells     
      

 To select:  Do this (If you are left-handed use Right click in place of Left): 

       

 a single cell  Left click on it   
       

 a range of adjacent cells  
Drag from the first cell to the last cell, or click on the first cell, hold the 
Shift   

   key and click on the last cell (scrolling if necessary)   

 non-adjacent cells or ranges  Hold CTRL (Windows) or Command (Mac) key and click or drag   
       

 an entire row or column  Left click on the row or column heading   
       

 all cells  Left click on the blank header in the upper left corner   
       

 the next cell to the right  Use the Tab key   
       

The Ribbon 
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 the next cell down the column  Use the Enter key   
       

 the A1 Home cell  Press Ctrl + Home keys together   
       

 the last cell in a sheet  Press Ctrl + End keys together   
       

 the cells around the active  Press Ctrl + Shift + 8 keys together (Select Region)   

Cell     

     3 
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Data 
 

Entering Data/Text 
 
Just click on the cell and type away! You can also copy text or data from another source (a word docu-
ment, another cell, etc.). Just right-click on the cell and select “Paste.” If you are working on a Mac (or for 
whatever reason cannot right-click), go to the “Home” tab on the ribbon and select “Paste.” 
 
Important: if you are copying data that was produced in excel using a formula, especially if you are copy-ing 
it to a different sheet or book, make sure you paste only the data, not the formula. To do this, copy the 
cell(s) as usual, then right-click on the cell where you would like to paste the number(s) and select “Paste 
Special.” A box will pop up with a number of different options. Under the Paste section, click on the bubble 
that says Values and then click OK. This is very important when you are transferring data from one sheet to 
another sheet or book, because the formula will reference cells in the new sheet that may have different 
numbers or no numbers at all. This will alter your data to reflect the data in the cells that the formula 
recognizes. 
 

 
Editing Data/Text 

 
If you want to entirely replace the data that you previously entered into the cell, just click on it and type 
the new data. The old data will automatically be erased. 
 
If you want to edit data in a cell, click on the cell, then go up to the formula bar and edit the data that ap-
pears there (see Fig. 3). If you want to delete part of your entry, just use the “backspace” key as usual. If you 
want to delete the entire contents of a cell (or multiple cells), select the cell(s) you want to clear and press 
the “delete” key. 
 
 
 
 
 
 
 
 
 
 
 

Then edit 
        the data  

                 
 

Click on the formula  
bar cell with the data 
you want to edit 

 
Fig. 3: Editing data 
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Autofill 
 
Autofill allows you to quickly fill data in a series (e.g. months, days of the week, or a numeric series) into 
adjacent cells. 
 
 

Using Autofill with a text series 
 
To use the Autofill function with text, type in the first word of the 
series (e.g. January), then rest your mouse on the bottom right 
corner of that cell. The cross will switch from white to black: this is 
the autofill cross (see fig. 4). Click and drag the series down or 
across the number of cells you would like to fill with this series. 

 
 

Autofill  
Cross   

Fig. 4: Autofill with Text 
 
Excel knows how to Autofill months (January or Jan) and days of the week (Monday or Mon). You can teach 
Excel to Autofill other text series. First, click on the Office Button and choose “Excel Options” in the lower 
right corner of the menu. In the “Popular” category (the one that appears automatically), click on “Edit 
Custom Lists...” (see fig. 5).  
 
 
 
 
 
 
 
 

 
Click to 

Create a Cus- 
tom List 

 
Fig. 5: Excel Options Menu 
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Type your list 

here, press-ing 
enter after  

each item. 
 

 
Click here to  

import a list 

already entered 

into your spread- 

sheet.  
 

Fig. 6: Custom Lists Menu 

 
 
When the Custom Lists window ap-
pears, select “New List” in the column 
on the left (it will probably already be 
selected) and type your whole list in the 
column on the right (see fig. 6). You can 
also import a list you have al-ready 
typed into cells by clicking on the import 
symbol (see fig. 6), selecting the list you 
wish to import, and pressing “Enter.” 
Click “OK,” and from now on you can 
type the first letter of the list, and just 
autofill the rest! 

 
 
 
 
 

 

 5 
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Using Autofill with a numeric series  
You can also use Autofill to quickly enter numeric patterns (e.g. 1, 2, 3 or 10, 20, 30) into adjacent cells. 
 
To use Autofill with numeric patterns, enter the first two values in the series, one value in one cell and the 
next in the cell immediately below or to the right. Now select (highlight) both cells, release your mouse 
button, then rest your cursor on the bottom right corner of the selected area so you see the Autofill cross. 
When you see the Autofill cross, click and drag down or across the cells you want to fill, then release the 
mouse button. 
 
 

 
Controlling Your View Of Data  
Auto Size: You may have noticed that sometimes data extends beyond the width of the column. In order to 
be able to see all of the data, you must widen the column. To do this, go to the header row and place your 
mouse in between the columns (e.g. on the line that separates the letters A and B). You will notice that your 
mouse becomes a black double arrow. If you double click on this arrow, the column will auto-matically size 
itself to fit the longest string of data in a cell. However, this does not adjust automatically so you may have to 
Auto Size again after adding more data. 
 
Freeze Panes: Freeze Panes is a useful feature when you are working with a large document that has many 
rows and columns. By freezing a certain row or column (usually the header and/or first column), you make it 
visible wherever you are in the document. For example, if you have a document with 100 rows, you can’t see 
the header row when you’re at cell A100. To solve that problem, click on the row below the one that you 
would like to freeze. To freeze the header row or first column, go to the Ribbon and click on the View tab. 
Then, click on the arrow below the “Freeze Panes” button and select “Freeze Top Row” or “Freeze First 
Column.” By selecting “Freeze Panes,” you can freeze all rows and columns above and to the left of the cell 
you have selected. 
 
Reveal Formulae: If you want to see and/or print all of the formulae in a spreadsheet (as opposed to the 
values) there is a really handy shortcut. Simply press Ctrl + ~. To return the view to displaying values, press 
Ctrl + ~ once again. 
 
 
 
Sorting and Filtering  
Sorting data is simply a way of automatically re-ordering rows on a spreadsheet to put them in a more 
useful order. For instance, you might sort an address book alphabetically by last name, or a list of items 
you’d like to buy from most expensive to least expensive.  
Start by selecting the data you want to sort. It’s important to select all the columns in the data, not just the 
column you want to sort by. For instance, if you have a list of items in one column, with the prices in the 
next column, you would select both columns before running the sort. If your sheet has a “header row” at 
the top with labels for your columns (like “name,” or “price”) it’s a good idea to include that row in your 
selection as well, as you’ll see in a moment. 
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Once you have your data selected, click on the Data tab in the ribbon and then select Sort. This will cause 
the sort window to appear (see fig. 7). If your data has a header row, be sure “My data has headers” in the 
upper right corner is checked. Excel will then use your labels in the “Sort by” drop-down menu instead of 
the usual (unhelpful) “Column A,” “Column B,” etc. Now you can use the “Sort by” box to select the column 
you’d like to sort the data by, then use the “Sort On” drop-down menu to select how you would like to sort 
the data (“Values” means numeric order for a list of numbers and alphabetically for a list of words). If you 
want a way to sort data in case of a tie, click on “Add Level” in the upper left corner. This will add another 
set of similar options below your original sorting criteria. 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
Another way to organize data is to filter it. A filter only displays data that meet a certain criteria, such as all 
records for a certain day. To do this, go to Data tab > Filter. A dropdown arrow will appear in the header cell 
of each column of your worksheet. Click on the arrow and select the criteria that you would like to use as a 
filter (e.g. April 10th). The worksheet will now display only the records from that day. You can also use the 
AutoFilter tool to display the top or bottom 10 numbers in a column, only records with blank spaces in that 
particular column, records that have a value greater than a certain number in the column that you are 
filtering, etc. These options are all available under the dropdown arrow that you will see after going to Data 
tab > Filter. 
 
Formulas   
Select the cell that the formula result is going to be displayed in.  Operation: Sign: Example: 

The formula can be constructed in the formula bar or typed di- 

        

 
Addition + =A1+B1+C1+D1 

rectly into the cell in which you want the formula to begin. You 

 

 
Subtraction - =A1-A2 must always put the = sign before a formula, as this is how Excel  

recognizes what you are entering as a formula. Autofill helps  Multiplication * =C4*C5 

you fill in formulae quickly once you have constructed one in a  Division / =C4/D4 

cell. In order to Autofill, select the cell with the formula. Place 

        

 
Combination (___) = A1*(B1+C1)   

your cursor so the small black cross appears in the lower right 

Click to sort ties in 
your 
previous sorts 

Check to 
use column ti- 

tles in the “Sort 
By” menu. 

 

Fig. 7: Sort Menu 
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corner of the cell (+). Once that cursor is visible, simply drag your formula down the column (or across the 
row as the case may be). Autofill will change the cell references accordingly. (E.g.: If the formula in A3 is 
=A1+A2, when you drag that formula over to B3 then the formula becomes =B1+B2.)  
Note that cell references can also change automatically when you copy and paste a formula using the 
clipboard, unless you use an absolute cell reference (see below). 
 
 
Cell References  
There are two different types of cell references: 
•Relative Cell References: cell references that change when the formula is autofilled into different cells, as 
in the example above.  
•Absolute Cell References: if you don't want a certain part of your cell reference to change when you 
copy the formula to a new cell, you need to put a $ in front of the row and/or column part of the refer-
ence.  
E.g.: If the formula in A3 is =$A$1+A2, when you drag that formula over to B3 the formula becomes 
=$A$1+B2. 
 
 

 7 
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Autosum  
The AutoSum button allows you to quickly insert the SUM function. It is located in two places on the rib-bon: 
on the right end of the “Home” tab in the editing section, and on the far left of the “Formula” tab. Select the 
cell where you want to put the total and then click on the AutoSum button. Excel will insert the SUM function 
and take a guess as to what cell range you’d like to sum by listing the first and last cell in the sum, separated 
by a colon. Check to make sure the cell range is correct, then press enter to accept the function. 
 
Functions  
Excel has created hundreds of functions that prevent you from having to write out 

complex or repetitive formulae yourself. Functions can be inserted by by clicking on the 
function symbol (see fig. 8) to the left of the formula bar (see fig. 9). Functions can also 
 be inserted by clicking on the “Insert Function” button on the “Formula” tab or jumping to any 

of the subcategories of functions on that tab (see fig. 10). Yet another way to insert a 
function is to type the equals sign into a cell and begin to type  
the name of formula. A drop down menu will appear, from which you can select the formula. 
 
Functions can also be 'nested'; that is inserted into larger functions by using the appropriate amount of 
brackets. =AVERAGE(SUM(B2:F2), SUM(B3:F3))  
 
 
 
 
 
 
 
 
 

Fig. 9: Function button on Formula Bar  
 
 
 

Function sub catego- 
Formula ries for quick navigation  

Tab 

 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 10: Formula Tab Options 

 

Fig. 8: Symbol 
Function 



www.compuhelp.in                                                                                https:www.youtube.com/c/compuhelpindia                         
 

60 

                SCO 74 Level-II Sec 46 C Chandigarh (U.T). Contact: +91 – 9915005347, 9988365347       

     
 
 

 
 

 
 
Autocalculate  
Excel will automatically perform calcu-
lation on a set of cells that you select 
and display the results on the status bar 
in the bottom right of your window (see 
fig. 11). The default calculation is the 
SUM function, but you can change the 
calculation by right-clicking (Win) or 
Control + clicking (Mac) on 
the Au-toCalculate result. 

 
 
 
 
 
 
 
 
 
 
 
 
Results of basic 

functions for 
highlighted 

cells   
Fig. 11: Autocalculate 

 

Name Manager  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 12: Naming Groups 
of Cells 

 
 
 

 
You can use Name Manager to name a group of cells, and 

therefore only type one name when you want to perform a 
calculation with that group. This can be useful when you are 
performing many different calculations on the same set of 
numbers, especially when you want to perform these calcula-
tions across multiple sheets. To do this, select the cells you  

would like to name and name them in the “name box” next to the formula bar 
(see fig. 12). You can then perform any function on these cells (on any page of 
your workbook) by just typing the name you gave the cells in-stead of 
referencing the cell numbers (ex: =sum(Days)). You can edit the names you 
gave the cells and change which cells they refer to by clicking on “Name 
Manager” on the “Formula” tab. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

Name  
box 



www.compuhelp.in                                                                                https:www.youtube.com/c/compuhelpindia                         
 

61 

                SCO 74 Level-II Sec 46 C Chandigarh (U.T). Contact: +91 – 9915005347, 9988365347       

     
 
 

Charts 
 
A full discussion of Excel’s many charting options is 
beyond the scope of this handout. However, it is 
fairly straightforward to create a simple chart (and 
some complicated ones) using the chart wizard.  
Just highlight the data you wish to base your chart on 
(including header rows, if you have any) and click on 
the Insert tab and you will see the available charts 
there. When you click on a type of chart, you will be 
promted to select a subtype of chart. Once you have 
done so, the chart will appear on your spreadsheet. 
Three additional tabs will also ap-pear on your ribbon 
(see fig. 13), through which you can alter your chart 
by adding titles, changing data points, and many 
other options. 

 
 
 
 
 
 

 
New tabs to change  

   aspects of your chart 
 
 
 
 
 
 
 
 
Fig. 13: New Chart  

 
 
     Pivot Table 
 
A pivot table is a great reporting tool that sorts and sums independent of the original data layout in the 
spreadsheet. It is an interactive representation of a data table. One can rearrange the data and choose 
what to display and what to hide. The best way to find out what a pivot table can do is to create one. Let’s 
try an example: 
 
 
 
 

Inserting a Pivot Table  
First, set up categories and create some data (See Table 1): 

 
Table 1: Original Data 

 Who Week What Amount Spent  

 Joe 3 Activities $18  

 Beth 4 Food $17  

 Janet 5 Activities $14  

 Joe 3 Food $12  

 Joe 4 Activities $19  

 Janet 5 Car $12  

      
 
Now choose any cell in this table and choose the Insert tab > Pivot Table. Excel will select all of the cells in 
your table, and this range will appear next to Table/Range in the pivot table menu. At the bottom of this 
window you can choose where you would like the Pivot Table to be placed: new sheet or in an exist-ing 
sheet. If you select Existing sheet, you can choose the Pivot Table’s location by selecting or typing the name 
of the cell that you would like the top left corner to be. Click OK. 
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Arranging data on the table 
Drag the headers Who, Week and What into the Row Labels area, and the Amount header into the Values 
area. (Leave the Column area blank for now.) To change the placement of an item, drag the header title to 
the desired area. If the Amount tag does not show "Sum of Amount", click on it, select Value Field Set-tings, 
and choose the Sum option. You can use different functions other than sum, such as (sum, average, count, 
etc.) by changing this. Clicking on the arrows next to the headers gives options of showing/hid-ing specific 
data and reorganizing items in the column. Right-clicking on the row labels in the pivot table allows you to 
remove subtotaling for that category. You can also change the look of your Pivot Table by selecting the Design 
tab on the Pivot Table Tools portion of the ribbon.  
Let’s try another example. This time, drag Who into the Row Labels field, What into the Column Labels field 
and Amount into the Values field. This sorts your data in a different way. You can change the order of the 
columns the same way you changed the rows: by clicking on the arrow next to Column Labels. 
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Click to change the 
appearance 

   Click to change     
     the order 

  
 
 
 
 
 
 
 
 
 

 
Right-click here to 

remove the 
subtotal across 

from it (and all of 
the subtotals 

across from the 
other items in 
that category) 

 
 
 
 
 
 

 
Fig. 14: Pivot Table 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Drag 
these catego-  
ries into the 
fields below 
 
 
 
 
 

 
Click here and 

go to Value 

Field Settings 

to change the 

function  
performed on 
this category 

 
 
 
Troubleshooting 
Common sources of errors are parentheses that don’t match or missing arguments for functions. If your 
formula is free from those errors, here are some error values you might get: 
 

###### There is nothing wrong with your formula; the cell simply isn’t big enough to display the 
 result. Widen the column. 

#DIV/0 You are trying to divide by zero 
 • Correct the divisor 
 • If the divisor is a cell reference, check to make sure the cell isn’t empty 

#NAME? There is a name in the formula that Excel doesn’t recognize. 
 • If you used a natural language name, check the spelling 
 • If you typed in a function, check the spelling or verify that the function exists. 
 • If you are performing operations on text, enclose the text in double quotation marks 

#REF! A cell reference is not valid. Check to make sure your formula references the right cells. 

#VALUE! The formula uses the wrong type of operand or argument. Check to see that you’re not per- 
 forming math operations on labels or that arguments or functions that need to numeric are 



www.compuhelp.in                                                                                https:www.youtube.com/c/compuhelpindia                         
 

64 

                SCO 74 Level-II Sec 46 C Chandigarh (U.T). Contact: +91 – 9915005347, 9988365347       

     
 
 

 not referring to cells containing labels. This can also happen if you try to perform an impos- 
 sible mathematical function (ex: taking the square root of a negative number). 
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Printing 
The page breaks can be changed on an Excel spreadsheet so that it prints a bit nicer. This can also help to 
reduce the number of pages that get printed. 

1. First, check out how it is currently set to print with Microsoft (MS) Office Button > Print> Print 
Preview.  

2. If you want to change the page breaks, go back to the document and click the View tab> Page  
Break Preview button.  

3. Now you will see the spreadsheet broken up by blue lines with a page number in each region 
(see fig. 15).  

4. You can move these dashed lines by clicking on them and dragging them to change the page 
breaks.  

 
 
 
 
 

You can 
adjust the page 
breaks by drag- 
ging these lines 

 
 
 
 
 
 
 
 
 
 

Fig. 15: Page Break Preview 
 

Printing Only Part of the Spreadsheet 
1. Highlight the area that you want to print.  
2. From the menu bar, select Page Layout > Print Area > Set Print Area  
3. Now when you go to MS Office Button > Print Preview, you will see only the area that you highlighted.  
4. To go back to printing the entire document, use Page Layout > Print Area > Clear Print Area 
 
 

Printing a Section on Each Page 
If you want to print a section of your spreadsheet on every page you print (for example, printing the titles of 
your columns on every page in a long list of data), go to Page Layout > Print Titles, and select or type the 
name(s) of the row(s)/column(s) you would like to repeat on each page. 
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Microsoft PowerPoint 2007 
Basics 
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Microsoft PowerPoint 2007 Basics 

Microsoft PowerPoint 2007 has a completely redesigned user interface.  The standard menus along the top 
have been removed and replaced with a series of toolbars Microsoft calls “The Ribbon.”  These tool bars are 
changed using tabs at the top and try to automatically adjust themselves to the content you are working with.  
If you select an image it will automatically switch to the picture tools.  The new layout seems to offer easier 
access to most of the features of PowerPoint allowing for more complex documents to be created quicker. 

The Office Logo 

The first thing most people will need to relearn is where to go to open a document, 
create a new one, save your document and print.  Clicking the Office logo at the top 
left of the screen will provide most of the items formerly found under the file menu 
including those listed above.   Beside the logo you also will find a disk icon to save 
your document as well as the undo and redo buttons.  More buttons can be added 
to this “Quick Access Toolbar” through the word options mentioned in the next 

section. 
 
As you can see here the Office logo opens up listing your options for 
new, open etc. and also contains a list of your recent documents for 
quick opening.  Any of the items listed with an arrow beside them will 
replace the recent documents on the right with the options associated 
with the menu item.  You should also see at the bottom right of this 
menu a button for exiting PowerPoint and changing PowerPoint’s 
options. 

Save as 

The save as option will provide you with the most common file formats 
to save your document in.  The common ones are PowerPoint 
Presentation, PowerPoint Show, and PowerPoint 97-2003 Presentation.  
The last one is the option most people should be using currently, 

especially if they wish to share documents with others who do not have the new version of Office. 

Print 

Here you can choose from Print, Quick Print and Print Preview.  Print brings up the standard print dialog box, 
quick print will print one copy without any dialog box coming up and print preview will bring up the print 
preview screen. 
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Prepare 

The prepare menu’s most common options are Properties, Inspect Document, Mark as Final and Run 
Compatibility Checker.  The properties option allows you to setup metadata for the document like Author, 
Title, keywords, comments and others.  Inspect Document will scan the document for any hidden data like 
comments and annotations, and any hidden collaboration data.  This is very useful when making a previously 
private document public.  It will help you find any comments or changes made previously that should not be 
made public.  Mark as Final will mark the document as a final copy and make it read only so changes cannot 
be made.  The last common item, Run Compatibility Checker will scan the document for new features that 
were used and show you these.  This is recommended if you where creating a document in the new file 
format but now need to convert it back to the Office 2003 format to share with someone who does not have 
Office 2007. 

The Home Tab 

 
The home tab the basic formatting tools found in PowerPoint 2007.  You will find five sections, Clipboard, 
Slides, Font, Paragraph and Editing.  Clicking the down arrow beside any of the icons here will drop down 
more options for that tool.  Each section except slides also contains an arrow in the bottom right corner which 
will open a window containing the options found in that section. 

Clipboard 

The Clipboard allows you to cut, copy, paste and copy formatting from one place to another.    
 
 
 
 

 

Slides 

The slides section has tools to add new slides, change the layout of a slide, also reset or 
delete a slide.  Both the New Slide and Layout sections offer drop down menus with 

predefined slide layouts to use.   
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Font 

The font section of the ribbon provides a section to handle the basic text 
formatting.  Items such as bold, underline, strikethrough, highlight and font 

type can be changed here.  There are also some items like character spacing and text shadow.  Some items 
from this section and some items from the paragraph section are also available by highlighting text and 
moving your cursor slightly above the highlighted text.  This saves having to move your cursor all the way to 
the top of the screen for some common formatting items. 

 

Paragraph 

The paragraph section provides icons for bullets, lists, justify, line spacing, 
indents and text direction.  You can also access tools to align the text 
vertically within a section and add smart Art graphics. 

 

Drawing 

The main part of the drawing section gives you a large 
number of shapes, lines arrows and flowchart pictures.  

The arrange icon is used to bring an item forward or backwards on the screen or group and ungroup objects.  
The quick styles icon gives a drop down with predefined shape style options or you can use the shape fill, 
shape outline, or shape effects icons to create your own styles. 

 

Editing 

The Editing section of the toolbar allows you to find, replace and select items.  The select 
option gives you the ability to select all, select objects or select text with similar formatting.  
This last option gives you the ability to quickly change everything in your document with one 

style to another style without having to manually find all of that text and change each area separately. 

Insert Tab 

 
The insert tab has five sections for inserting most types of objects.  The sections are tables, illustrations, links, 
text and media clips.   
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Table 

The table section only has a drop down menu which offers a grid to create a new table, insert 
table, draw table, convert text to table for selected text, Excel spreadsheet, and some predefined 
“Quick Tables” that have formatting already setup for you.  When working on a table you will have 

two additional tabs along the top of the ribbon, the design and layout tabs.  There are screenshots of both 
directly below. 

Table Design 

 

Table Layout 

 

 

Illustrations 

The Illustrations section allows you to insert pictures, clipart, 
photo albums shapes, Smart Art and charts.  After inserting or 
selecting a picture you are provided with a new toolbar along the 
top shown here.   This toolbar gives you the ability to change the 

brightness, 
contrast, 
shape, 
position, 

text wrapping and other options for the picture.  Clicking off the picture or on one of the other tabs will take 
you back to the standard toolbars.  The Shapes option of the Illustrations section allows you to insert lines, 
arrows, boxes, basic flowchart shapes and a number of others.  The SmartArt option provides features like org 
charts, flow charts, illustrated lists and processes.  The Chart option is similar to PowerPoint 2003 but it offers 
more options for your charts. 
 

 

Links 

The links section provides options for inserting hyperlinks, or actions.  The actions option 
allows you to link an item to a hyperlink, program, sound or macro. 
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Text 

Options in the text section include text box, Header and Footer, 
WordArt, date and time, slide numbers, symbols and objects.  There is a lot of option in here to setup on your 
own or you can use Words predefined options. 

 

Media Clips 

Sounds or movies can be added through this section.  A large number file types can be added 
here including, mp3, midi, wav , wma, wmv, avi and many others. 

 

Design Tab 

 
The design tab has three sections, Page Setup, Themes and Background.   
 

Page Setup 

Page setup provides you with the tools to slide size and orientation.  The slide size option 
allow for some predefined sizes like letter, legal, overhead, and tv aspect ratios like 4:3 

standard resolution and 16:9 widescreen.  
 

Themes 

 
The themes section gives predefined colour, fonts and effects or you can choose your own. 

 

Background 

The background section lets you choose a background style or hide the background on 
the selected slide. 
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Animations Tab 

 
The animations tab contains three sections, preview, animations and transitions to this slide. 

 

Preview 

The preview section will show you’re the current slides animation to allow you to check it is the way 
you want it. 

 

Animations 

Here you can create your own animations for use in the slide. 
 

Transition to This Slide 

 
The remainder of the Animations tab is taken up by the Transition to This Slide section.  Here you can apply 
different transitions to be used between slides like fades, slides and many more.  You can set options for 
speed, sounds, and timing.  

Slide Show Tab 

 
The Slide Show tab contains three sections, start slide show, set up and monitors. 
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Start Slide Show 

The start slide show section is used to start your slide show either from the 
beginning or the current slide.  You can also use this section to create a 
custom slide show.  Custom slide shows can be used to create one thirty 

minute presentation and one sixty minute presentation using the same set of slides but omitting some for the 
shorter show. 
 

Set Up 

The main features of this section are setup a slide show, record narration and 
rehearse timings. 
 

Monitors 

This section provides the tools to change the resolution of the slide 
show choose which monitor to display it on if you have multiple 

monitors and use presenter view if you have multiple monitors. 

Review Tab 

 
The review tab offers three sections which include proofing, comments, and protect. 

 

Proofing 

The proofing section provides the standard spelling check, a thesaurus, 
research tools that include MSN search and Microsoft Encarta encyclopedia.  You will also find translation 
tools to help with single words or the whole document.  The translation of the entire document is done by an 
online service called Word lingo. 

 

Comments 

The comments section allows you to add comments to a document for easier 
collaboration.  You can cycle through the comments to find out what notes you left for yourself or others and 
you can delete a comment that was made when it is no longer relevant 
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Protect 

The protect section gives you options to add a password and protect the document.  You can 
restrict changes to formatting and editing or the whole document.  If you use Windows Live you can also 
manage permissions for specific users who also have Windows Live. 

View Tab 

 
The view tab offers six sections which include presentation views, show/hide, zoom, Color/Greyscale, window 
and macros. 

 

Presentation Views 

The presentation views section switches you between normal, slide sorter, 
notes page, slide show, slide master, handout master and notes master.  Normal shows you one slide in the 
centre with thumbnails of all slides to the left of the screen.  Slide sorter fills the centre with thumbnails of all 
slides which you can drag around to sort them.  The notes page view shows the slide on the top section and 
notes you add in a bottom section.  Slide show will start the slide show from the beginning.  The Slide master, 
handout master and notes master views allow you to change what the presentations themes will follow by 
working with a master setup.  Each of these master views also provides another tab to the ribbon. 

Show/Hide 

The show/hide section will toggle certain tools on or off the screen including rulers, gridlines 
and message bar.  The rulers will show along the top and left side of the screen.  Gridlines will 

cover your entire document inside the margins.  They will be visible on screen but don’t print.  The message 
bar can only be displayed when there is a message to be displayed.  One common reason for the message bar 
to display is when macros have been enabled or disabled.   

Zoom 

The zoom section provides tools to zoom into or out of the document.   You can choose your 
own zoom factor or use one of the predefined zoom factors. 
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Color/Grayscale 

This section allows you to switch between color, grayscale or pure black and white.  This 
will allow you to see how slides will look when printed on a black and white printer. 

 

Window 

The new window button will open your current document in a new window.  The 
arrange all button will take your currently open windows and stack them one on top of the other.  This is also 
where you can easily switch between windows. 

Macros 

The macros section provides the tools required to work with and create basic macros.  You can view 
existing macros or record your own.  Choose record macro from the drop down and then perform the 
functions you do often, like change the page layout, and style of the document.  Once you have done those 
tasks then stop recording.  You will be able to use that macro over again to shorten the steps you need to 
take every time you need to perform that set of tasks. 
 
 
 
 
 
 
 
  


